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CCH® ProSystem fx® Knowledge Coach
Welcome to 2019 Knowledge-Based Preparations, Compilations, and Reviews of Not-for-Profit Entities for
Knowledge Coach
This Release Notes document provides important information about the 2019 release of Knowledge Based Preparations, Compilations and
Reviews of Not-for-Profit Entities. Please review this information carefully. If you have any questions, additional information is available on
CCH Support Online.

New in this Release
Knowledge-Based Preparations, Compilations and Reviews of Not-for-Profit Entities
This title can be installed on CCH® ProSystem fx® Engagement v2018 by first installing the CCH ProSystem fx Engagement v2018.2.4 Update
for Knowledge Coach. The latest update can be downloaded here. This update will allow users to use the 2019 content without installing
ProSystem fx Engagement v2019 until your firm plans to update.
It is designed to help the accountant efficiently and effectively perform financial statement preparation engagements, compilations, and
reviews of nonpublic not-for-profit organizations in accordance with Statements on Standards for Accounting and Review Services (SSARS)
issued by the Accounting and Review Services Committee (ARSC) of the American Institute of Certified Public Accountants (AICPA).
The Knowledge-Based Preparations, Compilations and Reviews of Not-for-Profit Entities methodology emphasizes using knowledge of the
entity to perform preparation, compilation, and review engagements by facilitating the flow of information so that the understanding
obtained in each process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities helps
the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the
appropriate accountant’s report, if any, is issued. This edition includes specific up-to-date guidance for conducting preparation,
compilation, and review engagements in accordance with the SSARS.
This document is published for the purpose of communicating the updates and enhancements included in the current version to users of
the toolset. This document is not and should not be used as a program to update the documentation of an engagement started in a
previous version of this product.
If you are updating from a previous version of this title, refer to the Knowledge Coach User Guide, Chapter 12. The guide is found on the
Engagement File Room Help menu.
The 2019 documents include CCH® Accounting Research® material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.
2019 Edition of Knowledge-Based Preparations, Compilations and Reviews of Not-for-Profit Entities
This edition features numerous enhancements, including:

•

New and modified procedure steps and practice points for current accounting guidance noted below.

•

New Microsoft® Word version of AID-301 to document Materiality. There will be no flow of Materiality but using the Microsoft®
Word version will allow the user to keep their data on roll forward.

•

Updating KBR-201, KBC-201, and KBP-201 to include a new tailoring question on whether the user will document consideration in a
memorandum format or considering each factor in detail. Also adding a new section on “Independence and Ability to Provide
Services”.

•

Adding new KBCRs, CORs, and RPTs as follows:
o

KBCR-901A Tax Basis Financial Statement Disclosure Checklist

o

KBCR-901B Cash Basis Financial Statement Disclosure Checklist

o

COR-902B Management Representation Letter: Compilation Engagement

o

RPT-0933A Compilation Report: Departure from Applicable Financial Reporting Framework—Substantially All Disclosures
and Statement of Cashflows Omitted

Click here for the 2019 Preparations, Compilations and Reviews of Not-for-Profit Entities Title Overview for Knowledge Coach Users.
In addition, forms and practice aids throughout have been updated to include new examples and tips, and where applicable, to consider
the following:
New literature, standards, and developments, reflected in the following current accounting guidance:
•
•
•
•
•
•

Statement on Standards for Accounting and Review Services No. 24 (SSARS-24), Omnibus Statement on Standards for Accounting
and Review Services - 2018)
AICPA Guide Preparation, Compilation and Review Engagements
The revised AICPA Code of Professional Conduct (Code), including ET Section 1.295, Nonattest Services
AICPA Statement on Quality Control Standards No. 8 (QC Section 10), A Firm's System of Quality Control (Redrafted)
AICPA Audit Risk Alert Developments in Preparation, Compilation, and Review Engagements - 2017/18
FASB Accounting Standards Codification™ as of September 30, 2019, through Accounting Standards Update No. 2019-07

Important:
•

Save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

•

If Microsoft® Word crashes when using Knowledge Coach, before closing the binder, use the Save Knowledge Coach Answers
option in the binder view under the Tools Menu. This saves all data within tables.

•

You can view other Knowledge Coach Best Practices on our website.

System Requirements
This title requires the 2019 Financial Statement Base Title. The 2019 Financial Statement Base title MUST be installed with one of the
following versions of CCH® ProSystem fx ® Engagement and Knowledge Coach.
•

Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or later available here. To identify
what version you are running, please go to the Help > About window within the application.

•

Engagement and Knowledge Coach v2018 or later.

If you are upgrading from Engagement v7.1 or lower please contact Technical Support.
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A minimum of 4GB of RAM is required for optimal performance when opening and navigating through Knowledge Coach workpapers.

License Requirements
This title requires the Knowledge-Based Preparations, Compilations, and Reviews of Not-for-Profit Entities license.
Any user that does not have a license for this title will not be able to use Knowledge Coach functionality in workpapers.
For more information on how to update your licensing, view How do I add or update CCH ProSystem fx Engagement Licenses? on our
website.
For more information on how to assign licenses, view How do I assign Engagement Licenses? on our website.

Download Instructions
If you are planning to use this title on Engagement and Knowledge Coach v2018, ensure you apply CCH ProSystem fx Engagement v2018.2.4
Update to all machines including Admin servers and terminal servers before installing the title. Review the Update's release notes for more
information on deployment.
To download this title:

1.

Navigate to the Knowledge Coach Updates section of the Engagement Support Website.

2.

Select the Knowledge Coach Series. The series are arranged by title type, then industry.

3.

Click on the Download File link next to the title you wish to download.

Note: On some occasions the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the
extension of the downloaded file to KCP using all capital letters.
You must install the 2019 Financial Statement Base title before installing the 2019 Knowledge Based Preparations, Compilations, and
Reviews of Not-for-Profit Entities.
The Financial Statement Base title is also available on the Knowledge Coach Update Website.
The Knowledge Coach Content Package (KCP) download is a proprietary file that must be installed from within Engagement. Save this KCP
file to a location on your local drive and follow the Installation Instructions below.

Installation Instructions
See How do I add a new CCH® ProSystem fx® Knowledge Coach title to CCH® ProSystem fx® Engagement? for instructions on installing a
new CCH ProSystem fx Knowledge Coach title.

Online Permission Key
Permission key files can be downloaded from our website or when adding or updating the new licenses in Engagement v2018 and higher.
After updating the license file in the Engagement Admin module, licenses must be assigned to the staff who will use 2019 Knowledge-Based
Audits of Not-for-Profit Entities.
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.
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Using Your Knowledge Coach Content with CCH® Accounting Research Manager®
CCH’s Accounting Research Manager (ARM) is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, and SEC literature, plus independent, expert-written interpretive guidance.
Available on ARM, the Knowledge-Based Preparations, Compilations and Reviews of Not-for-Profit Entities Guide helps you comply with the
most recent professional standards and guidance for the conduct of preparations, compilations and reviews and to integrate the use of
practice aids, tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based
documents that are available in Knowledge Coach.
If you subscribe to an ARM library that includes Preparations, Compilations, and Reviews of Not-for-Profit Entities content, you can link
directly to source material from Resources within Knowledge Coach documents. These links have been updated to refer to the accounting
standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Preparations, Compilations,
and Reviews of Not-for-Profit Entities Guide on ARM, you can take advantage of references to the guide material from within the
Knowledge Coach documents.
With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about our
content, our experts, and how you can request your free trial by visiting the Accounting Research Manager website. You can also access the
Accounting Research Manager Web site by selecting Engagement > Binder Window > Shortcuts Bar > Guidance tab.

Using Your Knowledge Coach Content
To use your Knowledge Coach Workpaper Templates, do the following:

1.

Open a binder in Engagement.

2.

Select the workpaper tab into which you would like to insert the workpaper.

3.

Select New Knowledge Coach Workpaper from the toolbar or File menu.

4.

Select the new Knowledge Coach title with the content you would like to use. You can only select titles you have installed. The
information displayed changes to reflect the workpaper organization available for the selected title.

5.

Select the Knowledge Coach workpapers to insert into your binder and click OK.

6.

In the Selected Workpaper Properties window, add a workpaper index in the Index field and make any Name modifications that are
needed. You can also modify the tab location or the roll forward settings for each workpaper.

7.

Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.

Additional Information on Knowledge Coach and the KBA Methodology
Knowledge-Based (KBA) Methodology
Allows the results of one set of procedures to become the input for the next. The key components of the KBA methodology include:
•

An Overview that guides accountants through the methodology.

•

Knowledge-Based Preparation, Compilation and Review of Not-for-Profit Entities documents, integral to the risk assessment and
overall accounting processes, which contain steps and procedures required by SSARS.

•

Customizable Programs that take accountants through related steps and procedures.
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•

Practice Aids to help accountants complete steps or processes outlined in the Knowledge-Based Preparation, Compilation and
Review of Not-for-Profit Entities documents and Programs.

•

Accountant’s Reports that provide a variety of sample accountant’s opinions on financial statements.

•

Correspondence documents that provide sample letters to be used to comply with SSARS requirements and in many other
common situations.

•

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2019 Knowledge-Based
Preparations, Compilations and Reviews of Not-for-Profit Entities are designed around the AICPA’s SSARS standards to assist
accountants by:
–

Facilitating compliance with SSARS.

–

Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids.

–

Enhancing engagement documentation.

CCH® ProSystem fx® Knowledge Coach
Knowledge Coach functionality allows accountants to use the Knowledge-Based methodology more efficiently by eliminating the need for
duplicate entry of the same information, tailoring documentation to each particular engagement, and documenting the link between risks
identified and procedures performed. PRP-100 Engagement-Level Tailoring Questions, CMP-100 Engagement-Level Tailoring Questions or
REV-100 Engagement-Level Tailoring Questions are documents in Knowledge Coach that presents engagement-level questions designed to
aid in tailoring the engagement documentation to fit each client. Completing the questions helps the accountant avoid duplication and
unnecessary workpapers.
Note: Before you begin your engagement, please review the guidance in PRP-101 Overall Preparation Program, CMP-101 Overall
Compilation Program, or REV-101 Overall Review Program. This workpaper is intended to be your road map through a Knowledge-Based
methodology. You should start your engagement with PRP-100 Tailoring Question Workpaper, CMP-100 Tailoring Question Workpaper or
REV-100 Tailoring Question Workpaper and PRP-101 Overall Preparation Program, CMP-101 Overall Compilation Program or REV-101
Overall Review.
•

Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows you to continuously assess risks during the engagement. Several workpapers prompt you
to consider the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented risks flow
to the Risk Summary. To ensure risks show in findings tables, select the workpaper identified in field of the Risk pane.

•

Information Flow helps reduce the time spent duplicating information across forms. In addition, the flow of consistent information
ensures that information and updates to information are not missed between workpapers. Drill-down functionality helps the user
navigate quickly to the source of the information, aiding in the review of the audit file.

•

Diagnostics help track unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant
assertions, missing workpaper, and more.

•

Links to Accounting Research Manager (ARM), if you subscribe to an ARM library that includes audit content, link directly to source
material from Resources within Knowledge Coach workpapers. These links have been updated to reference the accounting
standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA. Also, if you subscribe
to the Knowledge-Based Audits of Not-for-Profit Entities Guide on ARM, you can take advantage of links to the audit guide material
from within the Knowledge Coach documents.

•

Interpretive Guidance is integrated in each Knowledge Coach template through the Tips view of each new task pane. Informational
features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and
efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting Research Manager
and industry audit guides by simply clicking on the reference.
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Download Description:

Version:

2019 Knowledge-Based Preparations, Compilations and Reviews of Not-for-Profit Entities
Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or
later
OR
Engagement and Knowledge Coach v2019 or later
2019 Financial Statement Base

Release Date:

January 2020

File size:

18MB

Approx. Download Time:

42 minutes at 56 kbps

License:

Full Version

Platforms:

Microsoft® Windows® 7, 8.1, 10

Office:

Microsoft® Office 2013 or higher required
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